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Specair in 3 minutes 
Specair is a program for calculating emission or absorption spectra of air plasma radiation. It 
can calculate, display and save spectra based on a wide range of user input parameters. 

The main user interface sections of Specair are indicated in Figure 1 below. To create a new 
spectrum the user specifies the input parameters for a new spectrum in the Calculation Options 
area to the left, and presses the “Calculate spectrum” button in the top left corner. The new 
spectrum will be displayed automatically in the Plot area in the center. Comments to individual 
spectra can be added in the Comments Area at the bottom, and the appearance of the spectrum 
can be changed in the Calculated Spectra area to the right or under the Plot menu. By selecting a 
spectrum at the top of this area, the user can see the used Calculation Options in the area to the 
bottom right. 

In addition to calculating spectra, Specair can import experimental spectra in most of the 
commonly used file formats. Using Specair, the user can manipulate both imported and 
calculated spectra, by selecting the spectrum in the Calculated Spectra area and choosing among 
the options in the Data menu. 

The data can be exported to other applications either by choosing “Export spectrum” in the File 
menu, or by selecting “Display Data” in the Data menu and the use Copy and Paste to, for 
example, MS Excel. 

An actual plasma emission spectrum consists of many sharp lines, each broadened by several 
mechanisms including Doppler, collisional, natural or Stark broadening. In reality, however, the 
resolution of the collected data is determined by the instrumental broadening specific to each 
experimental setup. In Specair instrumental broadening is taken into account by convolving the 
plasma emission spectrum with a ‘Slit function’. The slit function represents the broadening 
caused by the spectrometer (slit width, pixel width, grating dispersion) and can be changed by 
selecting “Slit Function” from the Tools menu. The user can either use a trapezoidal slit 
function or import an experimental file. The imported file should be in a commonly used file 
format. 

Specair has about 60 input parameters, all set in the Calculation options, which together 
determine the wavelength and intensity for each peak in the spectrum. The peaks, which 
correspond to various transitions between the internal energy states of atoms or molecules, are 
determined by the population of plasma species in the various energy levels, the energy 
differences and transitions rules between the excited states, and the radiative transition 
probabilities.  

1. Temperatures 
The electronic, rotational, translational and vibrational temperatures, in Kelvin, define 
the respective Boltzmann population distributions of the internal energy levels. 

2. Pressure 
The pressure can be set using several different units, and determine radiation intensity 
and the level of absorption. 

3. Wavelength Range (nm) 
This specifies the wavelength range over which the spectrum will be computed. 
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4. Calculation Settings 
The calculation settings allows the user to change certain aspects of the calculations, 
such as whether to include absorption, to generate Mole fractions automatically, or to 
convolve the spectrum with a slit function, to replicate experimental conditions. The 
Speed display option is recommended as it reduces lowers the resolution to match that 
of the slit function. 

5. Mole Fractions 
The relative amount of each species is indicated here. For plasma consisting of only one 
species the value should be 1, otherwise use fractional values. For example, use 0.5 for 
N2 and 0.5 for CO, for two equal concentrations of these species. If the sum of the mole 
fractions of the species defined in your calculations exceeds unity, the program will still 
compute the spectrum, but a warning message will be given.  

6. Radiative  Transitions 
Specair includes most of the common transitions for air plasmas, but also for plasmas 
containing carbon species. The naming of the transitions conforms to the standard 
spectroscopy conventions. The spectroscopic transitions to model are selected by 
entering a ‘1’. To exclude the transition, set the value to ‘0’. The numerical value is 
used as a multiplier to the Einstein emission coefficients and to the population in the 
upper state of the transition. Although calculations should normally be performed with 
these parameters set to one, any other numerical value can also be used. For example, 
choosing a value of 2 is a convenient way to multiply the population of the emitting 
level by a factor of 2. This could be useful to determine the extent of nonequilibrium in 
the population of excited states. 

7. Room air absorbers to consider 
This section lets the user specify experimental conditions, compensating for absorption 
in the air between the plasma and the spectrometer. Note that the absorbing species are 
considered to be at room temperature for this option. Set species to On to include them 
in the calculations, and specify the path length of air, in cm, and the relative mole 
fractions (0.21 for 21% oxygen in air etc.). 
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Figure 1. Screen shot of Specair. 
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1. Introduction to Specair 
Specair is a computer program that models radiative spectra for plasmas. The areas of 
applications include analysis of plasma spectra and heat flux calculations, and it has been 
verified by numerous experiments. 

The calculations in Specair are based on a quantum mechanical model that describes each 
energy level of the species included. The species are the most important radiating atoms, ions 
and diatomic molecules present in air plasmas, e.g. N2, O2, NO, N2

+, N, O, C, …  The spectra of 
diatomic molecules are computed as described in. 

 
Laux, C.O., “Optical Diagnostics and Collisional-Radiative Models,” VKI Course on 
Hypersonic Entry and Cruise Vehicles, Stanford University, June 30 – July 3, 2008. 

The latest iteration of Specair combines a fast engine for calculations with an intuitive and 
versatile Windows-based user interface. The engine is written in Fortran, for maximal 
performance, and can calculate a high-resolution spectrum within a few seconds on a modern 
desktop computer. While spectra can be exported for advanced analysis or presentation 
purposes, the Specair interface provides many basic functions for immediate analysis. 
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2. The Specair User Interface 
The Specair user interface, see Figure 2, offers many functions, which are detailed in the 
subsequent sections. After specifying the Calculation options for a spectrum, the user starts the 
calculation by pressing the Calculate spectrum button, by selecting Spectrum > Calculate 
Spectrum from the menu bar, or by pressing the F2 button. Once calculated, the spectrum will 
be displayed and ready to work with, using the functionalities described below. 
 

 
Figure 2. The Specair user interface. 
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2.1. Menu Bar 

 

2.1.1. File menu 

 

New Project... Ctrl+N 
Create a new Specair project. This clears all the calculated spectra. The program will 
ask you if you want to save the current project, before closing it. 

Open   Ctrl+O 
Open an existing Specair project. A Specair project contains all calculated spectra and 
the options used to calculate them, as well as any imported files. 

Save   Ctrl+S 
Save the current project to a Specair data file. 

Save As 
Save the project as a new Specair data file. 

Import spectrum… 
Import a data file containing a spectrum. Most commonly use file formats are supported, 
such as Galactic .spc and JCamp-DX .jdx. For a text file the data should be listed in two 
columns, wavelength in nm and intensity, separated by spaces or tabs. 

Export spectrum… 
Export the spectrum selected in the Calculated Spectra area. For an ASCII text file 
output the file will contain two columns, wavelength in nm and intensity, separated by 
tabs. Specair also supports other commonly used file formats used in other applications. 

Save as image… 
Save the current view in the Graph Area to an image file. Several of the most popular 
image file formats are available (Bitmap, JPG, EMF, PNG, GIF, TIFF). 

Print graph…  Ctrl+P 
Open a print dialog box for printing of the current view in the Graph Area. 

Exit 
Exit Specair. 
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2.1.2. Edit menu 

 

Cut   Ctrl+X 
Cut the current field. Works with most text fields. 

Copy   Ctrl+C 
Copy the current field. Works with most text fields. 

Paste   Ctrl+V 
Paste the clipboard content to a field. 

Copy Image to Clipboard 
Copy the current view in the Plot Area to the Clipboard. The image can be pasted into 
other programs, such as MS Office. 

2.1.3. View menu 

 

Options   Ctrl+Alt+O 
Show the Calculation Options. 

Spectra   Ctrl+Alt+G 
Show the Calculated Spectra. 

Comments   Ctrl+Alt+C 
Show the Comments. 
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2.1.4. Data menu 

 
The data menu provides a number of operations that can be performed on both imported and 
calculated spectra. These functions are useful for correcting experimental spectra for drift, 
imperfect calibrations or different scaling. They also give the user a way to compare spectra, 
integrate them and to access the numerical data for further processing. 

Normalize 
Normalize all the selected spectra to a maximum value of 1. 

Normalize at Wavelength 
Open a dialog box for normalizing selected spectra at a given 
wavelength. The wavelength is initially set by the vertical marker but 
can be changed by the user. All spectra will be divided by the value 
the specified wavelength, determined by interpolation if necessary. 

Find Minimum 
Find the minimum value among the data in the selected spectra. The cursor is placed at 
that point and the coordinates are displayed in the top right corner until the mouse 
enters the plot area. 

Find Maximum 
Finds the maximum point similarly to the Find Minimum above. 

Set X Values 
Open a dialog box to perform basic arithmetic on 
one or several selected spectra (see right figure). 
Select an operator in the first field and enter a value 
in the second. The operation will be performed on 
the X value (wavelength) for each point in the 
spectra, which will be replotted in the graph area. If 
“Create new spectrum” is selected a new spectrum will be created and displayed in the 
plot area, leaving the original spectrum intact. 
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Set Y Values 
Same as Set X Values above, except that the arithmetic operation will be performed on 
the Y value (emission intensity or absorption coefficient). 

Subtract Baseline 
Open a dialog box for subtracting a linear baseline from a 
selected spectrum (see right figure). This can be used, for 
example, to compensate for background noise in the 
experimental apparatus used to measure imported spectra. 
Press OK to subtract a segment defined by the start and end 
values. 

Crop 

Open a dialog box for reducing the wavelength range of 
a spectrum. This can be useful, for example, to a small 
segment of an imported spectrum. The wavelength 
range is selected using the cursors in the plot area 
before selecting Crop, but can also be changed in the 
Crop window. If “Create new spectrum” is selected, a 
new, cropped copy will be generated, leaving the original spectrum intact.  

Add Spectra 
Open a dialog box for adding two or more spectra. A new 
spectrum, with the name specified by the user, will be 
created with y-values at each wavelength being the sum of 
all corresponding points in the selected spectra. The 
wavelength (x) values are the same as one of the input spectra, as determined by the 
user. The y-values for the other spectra are interpolated values at the same wavelengths 
before the addition, allowing the user to quickly add spectra from different sources. 

Subtract Spectra 
Open a dialog box for subtracting one of two 
selected spectra from the other A new spectrum, 
with the name specified by the user, will be 
created with y-values at each wavelength being 
the difference between the points in the top 
spectrum and the bottom spectrum, as determined 
by the user in the drop-down menus. The wavelength (x) values are the same as one of 
the input spectra, as determined by the “X values from” option. The y-values for the 
other spectrum are interpolated values at the same wavelengths, allowing the user to 
quickly subtract, for example, a calculated spectrum from an imported one to assess 
their agreements. 

Multiply Spectra 
Multiplies the points in selected spectra. Similar to “Add Spectra” above. 
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Divide Spectra 
Divides the points in one selected spectrum by those in a second selected spectrum. 
Similar to “Subtract Spectra” above. 

Average Spectra 
Averages the y-values for two or more spectra and creates a new spectrum. This can be 
used, for example, to consolidate data from several experiments under identical 
conditions. This operation is equivalent to “Add spectra” above, followed by a division 
by the number of input spectra. 

Integrate 
Display the result of the numerical integration of the selected 
spectrum. A trapezoidal integration, using the wavelengths, is used, 
and the units are dependent on the input spectrum. The average y-
value, equal to the area divided by the wavelength range, is also 
displayed.  

Convolve with Slit Function 
Convolve one or more selected spectra by the current slit function. Performing this 
operation on a non-convoluted spectrum is equivalent to selecting “convolution” for the 
“Slit function” option in the Calculation options. This menu option only works for 
spectra calculated in Specair. 

Display Data 
Open a window with data for the selected spectrum (see right 
figure). The data is represented as two columns, Wavelength (nm) 
and Intensity, and can be copied to other programs, such as MS 
Excel. Click in the top left corner to select all data. 
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2.1.5. Plot menu 

 

The plot menu contains all the options for modifying the plot area and the displayed spectra. 
This gives the user the option of creating professional-looking graphics, for presentation 
purposes, directly within Specair. 

The options for changing the properties can also be accessed directly by clicking on elements in 
the plot, such as the axes or the spectrum traces. 

Spectrum Properties 
All the selected spectra will be changed when using this option, 
which allows the user to change the look of the traces. Each 
spectrum can be represented using lines, markers or both, or be 
hidden completely. Lines can have different widths, colors and 
styles whereas markers have options for marker type, size, color, 
border width and border color. Each spectrum can also have an 
associated legend text. This is shown if a legend is used (see 
Legend Properties below) and can be different from the spectrum name. 

Plot Properties 
The look of the background is changed using this option. The 
“Plot Area”, encompasses the region within the axes whereas 
the “Chart Area” includes those outside as well. Both areas can 
have backgrounds consisting of a single color or have gradient 
or hatch patterns where a Secondary Color has to be specified. 
The areas can be surrounded by borders with different widths, 
colors and dash styles, and the user can also add a shadow to 
the plot area, defined by an offset and a color.  

Legend Properties 
A legend can be added to the plot by 
selecting the “Show Legend” box on 
the top left. The legend has many 
options, as seen to the figure on the 
right. The legend style includes 
options for the text associated with 
each trace, such as font and color. The geometry of the legend is defined by its style 
(column or row) and its docking and alignment. The docking defines which side of the 
graph the legend is placed on and the alignment selects whether it is placed in the 
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middle or a specific corner. The legend can be placed inside the “Plot Area”, i.e., within 
the axes. 

The legend can have its own title, with options for font, color, background color and 
alignment. This means that the title is associated with its own area, separated from the 
rest of the legend by a separator, which can also be defined in terms of style and color.  

The legend can have its own background, including gradients and hatch styles, just like 
the plot area (see above). Similarly it can have a border and a shadow. 

Title Properties 
A title can be added to the plot. Like the legend 
and plot areas it can have background effects, a 
border and a shadow. The title can be aligned to 
the left, middle or center and the text orientation is 
variable. The title also has a few text styles, such 
as shadowing. 

Axis Properties 
The axis properties window can change one or both axes in the 
plot area. Each axis has an axis title which can be changed along 
with its font, alignment and orientation. The axis range can be 
defined manually as can the crossing, if the user prefers the other 
axis to be placed somewhere in the middle of the plot. The 
default setting is for the crossing to be at the minimum of the axis 
range. The x-axis can be reversed and both axes can use a log 
scale, provided that all values are greater than zero. 

The width, color and dash style of the axes can be modulated. 
The labels can be removed and their font, color and orientation 
can be changed. 

Reset Axes  F5 
Set the axis range for both axes to encompass all visible spectra. 

Set Axes 
Set the axis ranges manually. This has the same effect as changing it 
under Axis Properties (see above) but the values can be preset using 
the plot markers. 
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2.1.6. Tools menu 

  

Calculate Spectrum  F2 
Calculate and display a new spectrum based on the current settings in the Calculation 
options. 

Duplicate Spectrum  Ctrl+D 
Create identical copies of all selected spectra. The new spectra have the suffix “_copy”. 

Slit function    F3 
Open a dialog box for defining and selecting a slit function. For more details please read 
the Slit Function section below. 

Spectrum type 
Specair can calculate both emission intensities and absorption coefficients. Both options 
use the same input parameters in the Calculation options. The spectrum types are 
displayed similarly in the plot area, but their units will differ. 

Speed display options 
Specair automatically uses an optimal spectral resolution in its calculations. This 
resolution is usually far greater than that offered by the experimental equipment, as 
defined by the spectrometer’s slit function. By selecting the Speed display found in the 
Calculation options only a small subset of all points will be imported from the 
calculations, to speed up the subsequent manipulation of the calculated spectra. This 
option displays a certain number of points for each slit function full width half 
maximum (FWHM), as defined by this Speed display option. 10 or 20 points is often 
sufficient. 

Temperature loop 
The temperature loop allows the user to make many calculations in 
one batch, while varying one or more statistical temperatures. The 
user defines the Start Temperature, the Step, which is the 
incremental increase in temperature, and the number of spectra to 
calculate. The temperatures not selected at the top will be held 
constant at the values entered in the bottom text fields. An example 
of the temperature loop, for the C2 Swan transition, is shown in the 
figure below. 
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Fit to Spectrum 
Specair can perform successive calculations to fit a selected experimental spectrum. The 
user can fit temperatures and mole fraction using several options. For more information 
see the section about curve fitting below. 

Find Transition 
This option helps finding unknown 
transitions in a spectrum, either by 
automatically matching peaks or by 
manually scrolling through a number of 
precalculated spectra at various 
temperatures and resolutions. The user 
can use a selected spectrum as input, or 
the residual from subtracting a selected 
spectrum and one calculated from the 
current settings. The second option is useful for identifying smaller peaks under a 
spectrum that has already been fit. The resolution is changed to most closely match that 
of the selected slit function. The Find Transition function is intended only for finding 
starting points for further fitting and the absence of a hit does not mean that a transition 
is not present in the spectrum. 

Global Fit 
The Global Fit function, or fit 
wizard, can be used in some 
cases where the user wants to 
fit a complex spectrum with 
several species and transitions. 
The global fit incorporates 
both the Fit to Spectrum and 
Find Transition functionalities 
to successively add new species and transitions, and then fit both temperatures and mole 
fractions in an iterative manner. For more information see the section about curve fitting 
below. 
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2.1.7. Help menu 

 
This menu contains resources for help and registration. 

Specair User Manual (pdf) 
Open the Specair User Manual (this document). An external pdf reader must be 
installed. 

Specair Website 
Open the Specair Website, www.spectralfit.com, in the default browser. 

About 
Display the current version and copyright information. 

Register 
Specair is available in a shareware version with limited 
capabilities. The full version is enabled by entering the 
Licence number and Registration key obtained when 
purchasing a license. For more information about licenses, 
please visit the Specair website, www.spectralfit.com, or 
send an email to license@spectalfit.com. 

mailto:license@spectalfit.com
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2.2. Toolbar 

 
 
The toolbar provides a quick way to access some of the most used functionalities, which are 
also found in the Menu Bar (see above). 

 
Calculates and displays a new spectrum based on the current settings in the Calculation 
Options. 

 
Open an existing Specair project. 

 
Save the current Specair project. 

 

 
Open a print dialog box for printing of the current view in the Graph Area. 

 
Show/hide the Calculation Options. 

 
Show/hide the Calculated Spectra. 

 
Show/hide the Comments. 

 
Reset the axes. 

 
Zoom in when selecting an area in the plot 

 
Enable the markers. The markers can be used to select an area without zooming, for use 
when cropping the spectrum, for example . 

 
Zoom out. This button is only available when the user has zoomed into an area. 
 

 



Copyright © 2012 SpectralFit, S.A.S.  Rev. 1.0.0 19 

2.3. Plot Area 
The Plot Area displays calculated and imported spectra as line charts. Wavelength in nm is 
displayed on the x-axis and intensity on the y-axis. 

2.3.1. Zooming 
The user can zoom in on a region of interest by selecting that region with the mouse while 
pressing the left mouse button (see figure right below). 

Scroll bars will appear along the two axes (see figure left below) allowing the user to move 
within the graph at the current magnification. Click on the round button at the left or top of the 
scrollbar to return to the previous magnification for the x- or y-axis respectively. 

 

2.3.2. Tracking 
Specair automatically displays the coordinates of a data point when the mouse pointer is placed 
on top of it. The coordinates are displayed the top right corner of the Plot Area (see figure below) 
and the units are identical to the axis units (nm for x and intensity for y). 
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2.4. Comments Area 
The Comments area consists of three tabs: Comments, Populations and Units. 

2.4.1. Comments 

 
The Comments tab lets the user add comments to each spectrum in text format. The entered 
comments are associated with the currently selected spectrum in the Calculated Spectra area. 

Analyzing an experimental spectrum might involve calculating many spectra in an iterative 
process. The comments section is there to help the user keep track of ideas or information above 
and beyond the Calculation Options, which are saved automatically. 

2.4.2. Populations 

 
The Populations tab displays, among other variables, the calculated electronic populations.  

2.4.3. Units 

 
The Units tab displays the different intensity units in Specair. The possibility of concurrently 
displaying many spectra of different origins, such as imported spectra and spectra calculated 
with or without convolving with a slit function, precludes a default intensity unit. Instead, the 
Unit tab provides a quick access to the Specair units and conversion factors.  
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2.5. Calculated Spectra 
All spectra, calculated and imported, are listed in the Calculated 
Spectra area at the top right of the Specair window. New 
calculated spectra are automatically named ‘New Spectrum’ plus 
a number, and imported spectra also have “(imported)” added to 
their names. The user can manually enter a new name after 
clicking on an already selected spectrum. 
 

 
Permanently delete all selected spectra from the current 
project. 

 
Hide or show selected spectra in the Plot Area. 

 

2.6. Options for Calculated Spectra 
The Options for Calculated Spectra are located at the bottom right of the Specair window and 
display properties a selected spectrum in the Calculated Spectra area. 

All spectra, both calculated and imported, have three properties that can be changed: Color, 
Visibility and Width. 

Color 
Spectra are automatically assigned a color, which is used when it is 
displayed in the Plor Area. This color can be manually changed by 
clicking on the drop-down menu (see figure to the right). 
 
 

Visible 
Set visibility of the spectrum in the Graph Area. Changing this property from True to 
False is identical to clicking the “Hide” button above. 

Width 
Change the line width, in pixels, for the spectrum in the Plot Area. The standard value is 
1, but higher values are possible. 

2.6.1. Calculated spectra 
The remaining options for calculated spectra are a copy of the 
Calculation Options used for the calculation of that specific spectrum 
(see figure to the right). These entries cannot be changed manually, but 
serve as a quick reference. 
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2.6.2. Imported spectra 
Imported spectra have no Calculation Options. Instead the name and 
path of the imported file is displayed (see figure to the right) 
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2.7. Calculation Options 
The Calculation Options, found in the left of the Specair window, represent all the variable 
input parameters for spectrum calculations. There are about sixty independent variables in total, 
all displayed in a single list. Some variables, such as temperature, pressure and mole fractions, 
represent the physical conditions of the simulated plasma. Others let the user specify what to 
include in the calculations, over which range and with which resolution. The following sections 
explain each of these input parameters. 

2.7.1. Temperatures 
In Specair, the populations of molecules in specific energy states are assumed to follow 
Boltzmanns distributions at the electronic, vibrational, or rotational temperature. The levels of 
atomic species follow a Boltzmann distribution at the electronic temperature. The fourth 
temperature is the translational temperature, which together with the pressure, defines the total 
density of the plasma, as well as the line broadening coefficients (Specair includes in general 
Doppler, collisional, Stark and natural broadening). See the section below on the physical model 
for more information. 

Electronic 
The electronic temperature determines the populations of electronic levels (Boltzmann 
distribution at Telectronic). 

Rotational 
The rotational temperature determines the population of rotational levels (Boltzmann 
distribution at Trotational). 

Translational 
The translational temperature is the classical thermodynamic temperature and 
determines, together with the pressure, the overall population of molecules in the 
plasma as well as the Doppler and collisional broadening widths. 

Vibrational 
The vibrational temperature determines the population of vibrational levels (Boltzmann 
distribution at Tvibrational). 

2.7.2. Pressure 

Pressure 
The pressure determines, with the temperature, the number density of species, and 
therefore the absolute intensity of the spectrum. 

Pressure Unit 
This entry specifies the unit used for the number in the pressure entry. The most 
common units are available (Pa, bar, mbar, atm and torr). 

2.7.3. Wavelength Range (nm) 
Specair calculates spectra over a wide range of wavelengths, from the UV to the IR.  



Copyright © 2012 SpectralFit, S.A.S.  Rev. 1.0.0 24 

Max 
The maximum wavelength of the calculated spectrum, in nm. 

Min 
The minimum wavelength of the calculated spectrum, in nm. 

2.7.4. Calculation Settings 

Generate mole fractions 
Specair will automatically calculate mole fractions in air plasmas if this value is set to 
yes. The generated mole fractions, for air at 1 atm pressure with 300 ppm CO2, are 
based on the temperatures. If this option is turned on the mole fractions entered 
manually in section “5. Mole Fractions” will not be considered. The calculated mole 
fractions are displayed in the Calculated Spectra section. 

Self-absorption 
When this option, relating to the radiative transport, is on Specair takes into account 
self-absorption of radiation within the length of the plasma slab (see entry on “width of 
slab” below). Turning it off means instead that all radiation produced will leave the 
plasma. 

Slit function 
With the Slit function option set to “no slit function”, Specair returns a spectrum with 
only Doppler, collisional, Stark and natural broadening. When set to “convolution” the 
spectrum will be convolved with the slit function specified in the Slit Function dialog 
box. 

Speed display 
With this option turned on the calculated spectra are returned with a resolution 
matching the Slit Function (see also Speed display options above). This significantly 
improves the speed and memory requirements without impacting the practical quality, 
and is the default option. The full resolution is returned with this option turned off, but 
this is not recommended as the program can quickly run out of memory. 

Wavelengths 
The returned wavelengths as observed in “air” or “vacuum”. The standard value is “air” 
as spectroscopic detectors are usually placed in room air. 

Width of slab 
Indicate the width of the plasma, in cm, along the line of sight of the spectrometer. The 
value determines the intensity of the calculated spectrum and is important when 
comparing absolute intensities with experimental data. 

2.7.5. Mole Fractions 
The relative amount of each species is indicated here. For plasma consisting of only one species 
the value should be 1, otherwise use fractional values. For example, use 0.5 for N2 and 0.5 for 
CO, for two equal concentrations of these species. For a non-zero result, the Mole Fractions for 
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the species responsible for the selected transitions (see below) have to be greater than zero. The 
species are written without subscript, i.e., N2=N2. 

2.7.6. Radiative Transitions 
The spectroscopic transitions to model are selected by entering a ‘1’. To exclude a transition, set 
its value to ‘0’. In the code, this numerical value is actually used as a multiplier to the Einstein 
emission coefficients or to the number density of the emitting state.  Thus using a value of 2 
would be equivalent to computing a spectrum with twice the population given by the Boltzmann 
distribution. This feature is left open such that the user can simulate a non-Boltzmann 
distribution for the emitting state of the selected transition. 

Specair includes most of the common transitions for plasmas made of N, O and C compounds. 
The naming conforms to the standard spectroscopy literature. 

2.7.7. Room air absorbers to consider 
Specair can include the effects of room air absorption in the calculations. This is useful when 
analyzing experimental data collected with an air-filled gap between the plasma and the detector. 

H2O 
Set value to “on” to include IR absorption by water molecules in a humid air path. The 
default value is “off”. 

H2O Length 
The optical path length, in cm, for the absorption by water molecules in the air gap. The 
path length refers to the total distance. 

H2O Mole Fraction 
The mole fraction for water in air. The standard value is 0.002, corresponding to 0.2%. 

CO2 
Set value to “on” to include IR absorption by carbon dioxide in the air gap. The default 
value is “off”. 

CO2 Length 
The optical path length, in cm, for the absorption by carbon dioxide in the air. The path 
length refers to the total distance. 

CO2 Mole Fraction 
The mole fraction for carbon dioxide in air. The standard value is 0.00036, 
corresponding to 360 ppm. 

O2 
Set value to “on” to include VUV (i.e., below 200 nm) absorption by oxygen in the air 
gap. The default value is “off”. 

O2 Length 
The optical path length, in cm, for the absorption by oxygen in the air. The path length 
refers to the total distance. 
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O2 Mole Fraction 
The mole fraction for oxygen in the gap. The standard value in atmospheric air is 0.21, 
or 21%. 

3. The Slit Function 
The slit function is a measure of the broadening of spectral lines due to instrumental broadening. 
The slit function can be determined, for example by measuring a laser with a well defined 
wavelength (usually a HeNe at 632.8 nm). In Specair, the user can import such a measurement, 
and use it in calculations to simulate a real measured spectrum. A user defined trapezoidal slit 
function, the simplest approximation of a true slit function, can also be used. Note that a 
Gaussian slit function is well simulated by a triangular slit function (i.e. a trapezoid of top = 0) 

To convolve a spectrum with the slit function, select “convolution” for the Slit function entry in 
the Calculation Options, and specify the slit function by selecting ‘Slit Function’ in the 
Spectrum menu, or by pressing F3, which opens the slit function window. 

3.1. Trapezoidal Slit Function 

In the absence of an experimental slit function, the user can specify a simplified one in the shape 
of a trapezoid. If the trapezoid is normalized to unity, i.e., the intensity is 1, the calculated 
spectrum will have the intensity given in mW/cm²/sr. To obtain a spectrum in units of 
mW/cm²/sr/µm, divide the above spectrum by the FWHM (in µm), which is indicated in the 
graph in the Slit function window (see figure below). 

 

3.2.  Imported Slit Function 

An experimental Slit function can be imported in the Slit function window by selectig “Define 
own slit function” and then pressing the “…” button to open a file dialog box. The format of the 
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imported slit function should be a text file with two columns, wavelength in nm and intensity, 
separated by tabs or spaces. 

The imported slit function will be displayed in the graph below, in orange, together with a linear 
interpolation in blue. The interpolation uses the same spectral step as that defined by the user in 
the “Spectral step” box and Specair uses this version during the calculations.  

IMPORTANT: It is strongly advised to cut off large wings of a slit function, such as those 
included in the example figure below, to avoid artifacts. Also, it is imperative to make sure the 
slit function does go to zero in the wings. 

The center of the imported slit function will be detected automatically, based on center of the 
line indicating the FWHM, and it is advisable to verify that this is done correctly, since an error 
in this value produces shifts in the spectral peak wavelengths. 

In addition, the FWHM is displayed, to aid in the calculation of absolute intensities. A spectrum 
calculated with an imported slit function will have intensities given in mW/cm²/sr, if the slit 
function is normalized to unity. This normalization can be done directly in the slit function 
window by pressing the ‘Normalize’ button with a value of 1 for the ‘Enter new peak value’ 
entry. A different peak value can be used if desired. As in the case of a trapezoidal slit function, 
the above spectrum can be divided by the FWHM (in µm) to obtain units of mW/cm²/sr/µm. 

Specair calculates both the FWHM and the “equivalent” FWHM. The latter is defined as the 
integrated area under the slit function, divided by the peak value of the slit function. To obtain 
spectra in units of mW/cm2/sr/mm, compute your spectrum with a slit function normalized to a 
maximum value of 1, and divide the obtained spectrum by the equivalent FWHM. 
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4. Spectral fitting 

4.1. Basic fitting 

4.1.1. Introduction to fitting 
Fitting to experimental spectra is central to plasma spectroscopy. The conditions in which the 
plasma was generated can be understood by finding the parameters that replicate the 
measurements. This is a difficult and iterative process as a complex plasma is described by tens 
of variables. Specair provides a numerical fitting routine which can greatly speed up the process. 
The option can be accessed by selecting a spectrum to fit, hereafter called the experimental 
spectrum, and then selecting “Fit to Spectrum” in the tools menu. This opens the window shown 
in the figure below. 

 

Specair implements Brent’s method to minimize a residual, the root-mean square of the 
difference between the experimental spectrum and the calculated spectrum. The spectra are 
calculated based on the current settings in the Calculation Options, including the slit function, 
which are held constant as either temperatures or mole fractions are varied until a minimum is 
found. 

Please note that all experimental spectra are normalized in the process of fitting. This means it is 
advisable to make a copy within Specair of any imported spectra. It also means that, for a 
spectrum with a single electronic transition, the actual spectrum being fit is independent of the 
electronic temperature, which only changes the intensity. Similarly, the result will be 
independent of the mole fraction if only one species is present in the plasma. 

The results from fitting are only as good as the starting point, the experimental spectrum. 
Specair automatically interpolates this spectrum before calculating the residual. It is advisable to 



Copyright © 2012 SpectralFit, S.A.S.  Rev. 1.0.0 29 

correct any drift or offset after an initial round of fitting, since a small offset in wavelength can 
lead to large residuals as sharp peaks no longer overlap. 

4.1.2. Input parameters 
The basic fitting routine normally minimizes the residual with respect to a single variable. A 
group of variables sharing the same value, such as all statistical temperatures under local 
thermal equilibrium (LTE), can also be used. The user manually selects “Temperatures” or 
“Mole Fractions”. All temperatures are fit simultaneously by default, but any combination of 
temperatures can be fixed while the others are varied. This is useful if the experimental plasma 
was not in LTE, such that vibrational and rotational temperatures, for example, have different 
values. The mole fractions, on the other hand, are fixed by default and the user selects the 
specific mole fraction(s) to vary by deselecting the check box. Several mole fractions can be fit 
together, but this is rarely useful in practice. 

The minimization works by bracketing a minimum residual and narrow the range using inverse 
quadratic interpolation. There are three general parameters by which the user can specify the 
starting conditions and the end point, listed to the left below the temperatures. The first is the 
“Initial Value”, which is the temperature or mole fraction which will be used in the first 
calculation. The second parameter is the “Initial Step”, which specifies, in percent of the Initial 
Value, the second and third calculations. If the first residual is lower than the second and third, a 
minimum exists in the region around the initial value and the routine will proceed. If instead 
there is a trend toward the second or third value the routine will keep extending the region, by 
the Initial Step percentage, until a minimum has been bracketed. This means that a smaller 
Initial Step is preferable is the Initial Value is close to the final fit result, whereas a larger Initial 
Step is better if the final value could be within a large, unknown range. The third option is the 
“Accuracy”, which is the threshold for stopping further iterations. It is given as a percentage of 
the final value, such that 0.1% returns an answer within a 1-Kelvin range for a final temperature 
of 1000 K. Lower accuracy, such as 1% or 2%, requires fewer iterations and hence leads to 
faster fitting. 

Unlike the temperatures, which are often between 300 and 12000 K, the mole fractions in a 
plasma can vary by many orders of magnitude. To quickly find a good starting point for fitting, 
the user can select “Find initial mole fraction”. This option starts by making a calculation at a 
very low mole fraction, specified under “First iteration”. Further calculations are then performed 
while increasing the mole fraction by an order of magnitude until a noticeable change in the 
residual is detected. The change in mole fraction between iterations is indicated under “Multiply 
by”, with 10 being the default, and the “Min residual change” is normally 0.l%. Once a 
sufficient change is detected the program proceeds to the regular fitting. 

4.1.3. Outputs 
For each iteration the iteration number, the value used in the calculation and the residual is 
displayed in the “Log” section to the right. This allows the user to directly observe the 
convergence and the improvement between successive fitting attempts. The magnitude of the 
residual will depend on both the overall magnitude of the spectra and the wavelength range, and 
is thus experiment specific. 
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Under the section “Add Spectra” the user can choose to calculate and display both the spectrum 
and the residual spectrum using the values found during fitting. The residual spectrum can be 
very informative when looking for underlying minor peaks or wavelength mismatches. 

4.1.4. Fitting methodology 
Due to the large number of parameters and the relatively long time for calculation, a brute force 
approach is often inadequate for spectral fitting. Any spectrum could, in principle, be fit by 
successively minimizing the residual for each parameter in an iterative manner, but in practice 
the number of calculations grow exponentially with the number of variables. So, if four 
different temperatures are used in combination with several species and transitions a guided 
approach is often superior. 

For a simple spectrum the recommended order is to start with the dominant Radiative Transition. 
The experimenter should use previous knowledge about the conditions, if possible, or use 
Specair’s transition finder, which contains a database of spectra for individual transitions at a 
few temperatures. Once a candidate species and transition combination has been identified the 
mole fraction is set to a number between zero and one and the user selects the “Fit to spectrum” 
option in the Tools menu. 

First the temperatures are fit together, unless the experimenter knows some of the temperatures, 
a priori. If the user believes that the selected transition accounts for the entire signal the next 
step is to fit each temperature separately. This is done by fitting primarily the vibrational and the 
rotational temperatures in an alternating fashion until both of them remain roughly constant 
between each round. 

If more species are found in the spectrum the next step is instead to add the most prominent one, 
followed by the optimization of the corresponding mole fraction. Adding more species and 
transitions will change the optimal temperature, so the next step is to once more fit the 
temperatures and subsequently all the mole fractions, in order of importance. This cycle is 
repeated until a true global minimum is found. If necessary the various temperatures can also be 
optimized in a similar fashion. When the residual stops improving between successive 
alternation between temperatures and mole fractions the user can add even more species and 
transitions or declare victory. It is clear that each added variable increases the dimensionality of 
the minimization problem and it is often the case that repeated cycles are necessary until the 
method has fully converged. The Global fit function in Specair (see below) can automate these 
steps in many cases and is a recommended approach for complex spectra. 

4.2. Finding transitions 
Specair includes an automated method for finding underlying transitions in a spectrum. With a 
spectrum selected, The Find Transitions window (see figure below) is accessed under the Tools 
menu. The transition finder is intended to be a starting point for analysis, to be followed by 
further optimization, and it uses an extensive database of pre-calculated spectra at different 
temperatures and with slit functions of different widths. 

In the Find Transitions window the user can browse all available transitions and temperatures 
by sliding the horizontal scroll bars. This is an intuitive way of finding the right transition and 
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the proper temperature range that is much faster than calculating plenty of candidates from 
scratch. 

The transition finder can also find the best candidates automatically, by searching the database 
for spectra that match the highest peak within the specified wavelength range. When pressing 
the Find transition button suggestions are returned in order of best fits. The Peak wavelength 
tolerance (nm) number indicates the small wavelength range around the main peak that will be 
considered. Increasing the range returns more hits, and can be useful if the experimental 
spectrum has an offset, but it also increases the number of false positives.  

The default setting for the comparisons is to use the spectrum that was selected when opening 
the window. The user can also choose to “Use residual from settings”, where a calculated 
difference spectrum is used. A spectrum is calculated based on the current Calculation options 
and the difference between this spectrum and the selected, imported, spectrum is displayed, 
making it easier to find smaller peaks below larger ones that have already been fit. 

To further refined the search, the user can limit the overall wavelength in which to search for a 
transition. The spectra can be normalized either at their main peaks or at a given wavelength, as 
indicated by a vertical pointer in the graph. Finally, the resolution, as defined by a spectral 
step/slit function width combination, can be changed using the slider in the bottom left corner. 
A triangular slit function is implemented here. 

 

If a transition has been found the user can press the Update settings button to use the 
information for updating the calculation options or for fitting. This opens the Update settings 
window (see figure below). 

The user can add the selected transition, or all the transitions associated with the found species. 
For example, if N2 (1+) was identified the user can also add N2 (2+) at the same time. This can 
be done while alsso Clearing existing transitions, i.e., setting all Radiative transitions to 0 in the 
Calculation options. 
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The temperatures can be updated to that selected in the transition finder. There is an option to 
Fix Telectronic, which is useful, for example, when studying plasmas from electric discharges. 
Even though the plasma is cold, the electronic temperature is high, which is needed to see a 
meaningful intensity. 

The min and max wavelength in the calculation settings will be updated to those indicated in the 
transition finder unless the user chooses to Use existing settings. The wavelengths in the 
transition finder are those of the input spectrum by default, but can be changed by the user. 

Under “Species” the user can specify the new value for the mole fraction associated with the 
selected transition. If Keep existing transitions is selected the user can choose to Keep existing 
mole fractions as well. There is also an option, Optimize new mole fraction, which 
automatically optimizes the mole fraction as described in the Basic fitting section above. 

Once a mole fraction has been set, the temperatures and mole fractions can be further optimized. 
These selections are listed under “Optimize after closing”. The Fix Telectronic option is similar to 
that above, intended to keep the electronic temperature high for reasonable intensities even if 
the other temperatures are low, as in the case of electric discharges. The other option, Telectronic= 
Trot, sets the electronic temperature to be equal to the rotational temperature before fitting the 
mole fraction. This could be used if a fixed electronic temperature was used previously, while 
trying to optimized the rotational temperature at a high intensity. 

The final options, under Add spectra, can be selected to automatically calculate both the final 
spectrum, after optimization for example, and the corresponding residual spectrum, i.e., the 
difference between the input spectrum and the calculated one.  

 

4.3. Global fit 
The Global fit window, accessed under the Tools menu and shown in the figure below, is an 
interface combining the basic fitting and the transition finder to streamline the fitting process. 
As described above, a general fitting procedure consists of adding transitions, one at a time, 
while optimizing all variables between each step. In the Global fit, both the addition of 
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transitions and the optimizations can be done automatically, significantly reducing the active 
time for the user. 

The transitions are added by pressing the “Add” button, which launches the Find transition 
functionality described above. If the “Add transitions automatically” is selected the transition 
finder uses the first choice among its suggestions. Otherwise the user can verify that the right 
transition is chosen and also manually change the transition. The “Peak wavelength tolerance 
(nm)” and resolution selector are the same as in the transition finder. More than one transition 
can be added automatically, with the number selected in the drop-down menu. This will add 
transitions in order of prominence, if “Optimize after adding” is also selected. 

The added transitions are listed below the graph window and they can be removed using the 
“Remove” button. After one or more transitions have been added the user can refine all 
parameters by pressing the “Optimize” button. The program will execute the basic fitting 
routine outlined above for all relevant variables, based on the last temperature used. The starting 
value for the mole fractions can be changed manually in the text boxes. Note that all plasmas 
have to be in Local Thermal Equilibrium (Telectronic=Ttranslational=Trotational=Tvibrational) when using the 
Global fit. For different temperatures a manual fitting has to be done. To reach a global 
minimum many cycles, determined by the “Number of iterations”, should be performed. 

The figure below shows an example where the peaks of N2 (2+) and N2 (1-) were identified and 
fit automatically. This particular spectrum was found to be out of Local Thermal Equilibrium. 
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5. The physical model for radiation used in Specair 

5.1. Energy levels 
Specair simulates emission intensities for a number of diatomic molecules. Emission occurs 
during molecule transitions from higher to lower energy levels. The energy of a level can be 
expressed as the sum of the electronic energy, the vibration energy and the rotational energy, 

( ) ( )( )stJFvGThcE veeeJve +++= '' ''''''' . 

The term st is a small term due to lambda doubling and spin splitting which will be discussed 
later. The energy of the electronic levels 'eehcT ε=  is often tabulated. Spectroscopy literature 

frequently expresses the vibration energy as the polynomial expansion 
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where the polynomial coefficients are tabulated. The energy of the rotational levels ( )''' JF ve  is 

calculated using a similar expression: 
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The polynomial coefficients are normally tabulated. 

However, for most transitions considered in Specair, the above expressions are not used.  
Instead, for the sake of accuracy, most energy states are computed in Specair by inverting 
Hamiltonian matrices. This method also allows the modeling of perturbations for several 
systems of importance in Specair (such as N2 first and second positive, N2+ first negative, NO 
alpha, beta, gamma, delta). More details about Specair can be found in the following publication: 

 
Laux, C.O., “Optical Diagnostics and Collisional-Radiative Models,” VKI Course on 
Hypersonic Entry and Cruise Vehicles, Stanford University, June 30 – July 3, 2008. 

 
The general notation for an electronic level is Λ+12S . S is the quantum number associated with 
the total electron spin, and Λ is the quantum number associated with the absolute value of the 
projection of the orbital angular momentum along the internuclear axis. Λ takes the values 
0, 1, 2, 3 associated with the Greek letters Φ∆ΠΣ ,,, . The number 2S+1 is called the spin 
multiplicity and the notation for each state is usually preceded by an identifying letter, often X 
for the ground state. 

5.2. Spin 
Each electronic level is split into 2S+1 spin substates (spin-splitting) and for all 1≥Λ , every 
spin substate is split in two Λ -substates (Λ -doubling). This gives us the degeneracy for each 
electronic level as ( )( )Λ−+= 0212 δSge , where Λ0δ is the usual Kronecker delta. For 

diatomic molecules with nuclei of equal charges a u or a g is written to the right of the term 
Λ+12S . This indicates if the electronic wave function is symmetrical or not with respect to the 

operator î, which inverts the coordinates of the nuclei and the electrons relative to the 
molecule’s center of mass. The letter g indicates that the wave function is symmetric (gerade), 
and a u indicates that it is not.  
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For Σ -states a “+” or a “–“ is showed to the right of the term . This indicates if the electronic 
wave function is symmetric relative the operator vσ which corresponds to a mirror reflection 

through a plane containing the internuclear axis. 

To designate the spin substates the notation Ω
+ Λ12S is often used. Ω is the quantum number 

associated with the projection of the total angular momentum J along the internuclear axis. For 
diatomic molecules the total angular momentum exclusive of nuclear spin is the vector sum of 
orbital (L), spin (S) and rotational (R) angular momenta, J=R+L+S. The projection of R on the 
internuclear axis is zero, the projection of L is units of momentum, the projection of S is hΣ and 
the total projection of J is hΩ . For a Π2 state ( )21,1 ±=Σ±=Λ , this gives us four 
possible values of Ω, 3/2, 1/2, -1/2, -3/2. A common notation is to just give the absolute value of 
Ω, and distinguish the positive values from the negative by their parity. We use (e,f) as parity 
notation and this gives the following notation for the four spin substates of the Π2 state:  

f,2
3

2Π , 
e,2

3
2Π , 

f,2
1

2Π and 
e,2

1
2Π .  

For rotational levels, the notation F1, F2…F2S+1 is used to designate the 2S+1 spin substates. The 
rotational energy is a function of the total angular momentum (rotational quantum number) J. 
As seen above Ω is the projection of J on the internuclei axis which gives that J can never be 
less than Ω. 

5.3. Selection rules 
For spontaneous transition between two states to occur, the transition has to fulfill the following 
conditions: 
• 0=∆S  
• 1,0 ±=∆Λ  
• gu ↔  
• −−++ Σ↔ΣΣ↔Σ or  

• 
1 or

0
1 or

e e f f
J e f

e e f f

− → →
∆ = →
 → →

 

All other transitions are so rare that their emission has no significant importance for the detected 
radiation. As we can see, selection rules limit the possible transitions between different 
electronic states and rotational levels. There are no such limits for the transition between 
different vibration levels, between these levels everything goes. 

5.4. Example 
Figure 3 below, an image from Herzberg, p. 267, illustrates transitions between states. It 
represents the energy level diagram for a 2 2 +Π − Σ  band where only the levels for J between 
10.5 and 15.5 are included. K stands for the total angular momentum apart from spin. The 
broken-line branches are satellite branches and the dotted branches do not appear in a strict 
Hund’s case (b).∆ -type doubling is present in the 2Π state. Hund’s cases distinguish different 
modes of coupling of the angular momenta. 
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Figure 3  Energy level diagram from p.267, Herzberg, G., “Molecular Spectra and Molecular Structure, 
Volume I – Spectra of Diatomic Molecules”, Krieger Publishing Company. 

5.5. Emission intensity 
The emission intensity due to a transition from the upper energy level (e’,v’,J’) to the lower 
energy level (e’’,v’’,J’’) is expressed as : 
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The expression gives the emission intensity as a product of, the number of molecules in the 
upper state (e’,v’,J’’), the probability for spontaneous transmission from the upper state to the 
lower state and the energy difference between the two states. The probability constants, 

( )∑ 2'''Re vv and '''JJS are both tabulated values and are not calculated by Specair. The 

population in the upper state is calculated with the expression 
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where N is the total number of molecules, 'eg is the degeneracy of the electronic level e’, k is 
Boltzmann’s constant, elε is the electronic energy, vε  is the vibration energy and Jε  is the 
rotational energy for the state. elT , vT  and JT  are the temperatures associated with the 
electronic, vibrational and the rotational levels respectively. Finally ( )0λλφ −  is the line shape 

function. 
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